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Zaklady prace
v prostredi MATLAB

Jak bylo zminéno vySe, pro efektivni praci je tfeba mit spustény MATLAB. Nebu-
deme se vénovat detailnimu popisu instalace, pozadavk( na vybaveni pocitace atd.
Pravdou je, Ze na pomalém pocitaci s malou operaéni paméti bude prace vyZzadovat
pevné nervy. Budeme piedpokladat, Ze pracujete na legalné zakoupené &i pfidélené
licenci.

Spusténi MATLABu:

Nemate-li na pracovni ploe pocitale (pfedpokladame operacni systém MS Win-
dows 95 a vy38i) pfisludnou ikonu, pak spustitelnym souborem je soubor MATLAB.exe.
Je umistén ve slozce (adresafi) ...../.MATLABG6p 1/bin/win32. Je vSak tfeba hned po-
znamenat, Ze to plati pro aktualni verzi 6.6. a v pfipadé, Ze pfi instalaci nebyla zmé-
néna cilova slozka ..... /MATLAB6p1. V jinych verzich, zejména nizSich, je cesta
k souboru MATLAB.exe pozmé&néna, soubor sam je vSak stejného jména. Poznate
jej podle typického grafického symbolu oranzové barvy.

2.1 Strucny pruvodce pracovni plochou

NeZ se pustime do vlastni prace, poznamenejme, Ze soucasnou aktualni verzi
MATLABU je verze 6.6. Ta bude pfedmétem popisu ve skriptu. Verze 6 je oproti pied-
chozim typicka také ponékud modifikovanym pracovnim prostfedim. To je problé-
mem vS$ech systém(l podobného typu. Obcas je uzivatel postaven pred nutnost
pfizpUsobit se sice efektivnéjSimu a vykonnéjsimu prostredi, ale za cenu zmén svych
navyku.

Z davodu vyroby knihy jsme nuceni pouzivat jen ¢ernobilé obrazky, resp. obrazky
s odstiny Sedi. Bohuzel, nékdy je to pravé barva ¢i barevnost, ktera odliSuje razné
varianty pfikaz( a povelll a ktera ¢ini vizualizaci dat efektnéj$i. Sami jsme pfi praci
pouzivali operacni systémy MS Windows XP.

Vlastni popis pracovni plochy:

Po spusténi MATLABuU se nam otevre pracovni plocha nebo prostfedi. Jak je vidét
z obr. 2.1, sestava celkem ze tfi otevienych oken. Jedno okno je podstatné vétsi, je
v horni ¢asti nazvano Command Window. DalSi dvé mensi okna v levé Casti jsou
nazvana Launch Pad a Command History. VSimnéte si, ze tato mensi okna mohou




byt pfepnuta na jina. Okno Launch Pad muze byt pfepnuto na Workspace a okno
Command History na Current Directory. Pfepinani se déje kliknutim na zalozky ve
spodnich ¢astech téchto oken. Vysvétleme si stru¢né funkci téchto oken.

Funkce oken pracovni plochy:

Okno Command Window — je hlavni a nejdllezitéj$i ¢asti pracovni plochy. Sem
zapisuje uzivatel své pfikazy a povely, zde je vidét odezva MATLABuU a zde se zobra-
zuji systémova hlaseni. Toto okno si mizeme predstavit jako chytrou kalkulacku
s mnoha funkcemi a moznostmi.

Okno Launch Pad slouzi k rychlému spusténi fady nabidek. Jde o interaktivni

help, demonstracni samobé&zici vyukové programy demos, podporu tvorby grafic-
kych prostredkl atd. Staci si je vybrat a poklepat na né mysi.

File Edit Wiew Web Window Help
D ﬁ E ﬁ % | Currert Directory: |C:\Ja’\Matlab\Fazovaci\Vyvnj\FCnasabeﬂ J

7L MATLAE
To get started, select "MATLAE Help” from the Help menu.
}ﬂ Control System Toolbox g ’ P P

E

E

[]—ﬂ Image Processing Toolbox e
E]—ﬂszlgnal Processing Toolbox
#ofl symholic Math Toolhox
[}ﬂ[ﬂa\relet Toolbox

- B gimaling

#- ¥ D5P Blockset

E]—Qo Fixed-Point Blackset

[]—ﬁ SystemBuild to Simulink Trs
4

| ]
‘ | Launch Pad | Workspace
2l x|
radlfclllgr A
radlfclllgr
radZfcZzZigre
quit
g--  4:0% PN E/E7/02 --%
£c500
quit
H-- 817 MM 3/05/02 --%
WEr
§--  9:51 AM 3705702 --%
- |
‘>| Corrmand History | CurrentD) | < o

Ready

Obr. 2.1 Pracovni plocha po spusténi MATLABuU verze 6.6.

Okno Command History je velmi uzite€nym oknem. Zobrazuji se zde vSechny
pfikazy a povely, zapsané a potvrzené uzivatelem v hlavnim okné Command Win-
dow. Je-li potfeba jiZz jednou zapsany a potvrzeny pfikaz znovu pouZit, staci jej vtomto
okné nalistovat a poklepanim znovu aktivovat &i jej pfetdhnout mySi do hlavniho okna.
Totéz je véak mozné v hlavnim okné pomoci kurzorovych Sipek nahoru a dold.
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Okno Workspace bude pfi prvnim spusténi prazdné. Pfi pouzivani proménnych
v hlavnim okné bude v tomto okénku pfehled v8ech vami pouzitych proménnych.
Poklepete-li na symbol nékteré proménné, zobrazi se detailni informace o ni (rozmér,
struktura apod.). To je uzite€né zejména pfi pouzivani vétsiho mnozstvi proménnych
pro udrzeni prehledu.

Okno Current Directory ukazuje seznam souborl v aktualni (current) slozce (ad-
resari). Poklepanim mysi na néktery ze zobrazenych soubord jej oteviete ve vestavé-
ném editoru apod.

Current Directory (aktualni slozka) je zobrazena tésné nad hlavnim oknem (Com-
mand Window). Je mozné ji zménit podle potreby. Implicitni nastaveni je do slozky
...MATLAB6p1/Work, kam MATLAB predpoklada umisténi vysledk(i vasi prace.

Ukoncit praci se systémem MATLAB lze zapisem quit s naslednym ENTER nebo
mySi kliknutim na kfizek vpravo nahofe (standardni ukonceni v operacnim systému
Windows).

Funkce oken plné ocenite pozdéji, az budete zkuSeng&jsimi uzivateli. Pak vam
budou velmi Setfit Cas.

Menu nad okny pracovni plochy:

Nad vySe popsanymi okny pracovni plochy jsou dvé fady nabidek. Ta nize uvede-
né je ve formé tlaCitek. Slouzi k vytvofeni nového tzv. m-souboru, otevieni jiz existu-
jiciho, ke spusténi simulagniho systému Simulink a k dalSim funkcim, potfebnym
k editaci.

Nejvyse jsou umistény rozbalovaci nabidky — menu. MUzete si je prohlédnout,
vénovat se jim zatim nebudeme, nebot to neni nutné. Slouzi napf. k nastaveni cesty
k m-souborum ¢&i jinym soubortim, k detailnimu nastaveni pracovni plochy, vyvolani
helpu atd.

Co jsou to m-soubory:

Tzv. m-soubory, zminéné vyse, jsou textové soubory s pfiponou *.m. Slouzi k zapisu
posloupnosti pfikazi MATLABuU a jejich uloZeni napf. na disk. Jsou tedy zdrojovym
kodem, ktery umi MATLAB vykonat. Pokud si pouzZivané pfikazy neulozite, pfi zavie-
ni MATLABuU o né pfijdete. Jde tedy o soubory, které zatim nevyuZijete, ale které jsou
nezbytné napf. pfi programovani. Vice informaci prozatim neni tfeba. Pro ilustraci,
jenom popisu nastaveni pracovni plochy vénuji autofi MATLABuU v manualu nékolik
desitek stran.

2.2 Zakladni operace s Cisly

2.21 Elementarni operace s realnymi Cisly

MATLAB je svou podstatou nastroj pro praci s €isly (pomifime moznost dokoupeni
toolboxu pro symbolickou matematiku). Zaénéme praci s realnymi Cisly.




Prace s maticemi

a reseni soustavy rovnic

Programovy systém MATLAB je orientovan maticové. Matice je zakladnim objek-
tem s mnoha moznymi podobami a tomu je pfizplisobena struktura celého systému.
Kapitola 3 proto tvofi jadro knihy. Ukazeme si v ni zejména moznosti zakladni defini-

ce matic a prace s nimi.

3.1 Vytvoreni matic a vektort

Moznosti, jak vytvofit matici Ci vektor, je v MATLABuU nékolik. Zapiste v hlavnim
okné MATLABuU zapis: A=[1 2;3 4] a potvrdte pomoci ENTER. Zopakujme, Ze pouzi-
jete-li stfedniku za vyrazem, matice se nadefinuje, ale nevypiSe. Zapiste dale ostatni

vyrazy podle obr. 3.1.

Cormand Window

Cormrnand Window

> A=[1 2:3 4]
L =
1 z
3 4
==

= V1=[1l 2 3 4 5]

Wl =

2

Cormand YWindows

»» R22=[4 8 9:22 3 0]

Riz =

e

Obr. 3.1 Zakladni zptsob vytvoreni matice a vektoru
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Z obr. 3.1 je zfejme, ze matice se zapisuji po fadcich, které jsou oddéeleny stfedni-
kem. Prvky kazdého fadku jsou oddéleny mezerou nebo ¢arkou (méné casto). Je-li
matice jen jednofadkova, nazyvame ji fadkovym vektorem, v naSem pfipadé V1. Pfi-
tom pocet radkd, resp. sloupcl matice neni v principu nijak omezen.

Pro vytvoreni matic a vektorll mizete vSak pouzit také libovolné matematické
vyrazy a rovnéz proménné, jak ukazuje obr. 3.2.

Cornrmand YWin Cormmand Window
» REE=[Z*log(l0) exp(-0.1):;10 sin{pi);2+3i 0] = Pl=10:
»» PE=abs(l+li);
RzZ = = B=[1 1;Pl PE~Z]
4.6052 0. 9045 E =
10,0000 0. 0000
2.0000 + 3.00001 0 1.0000 1.0000
10. 0000 Z.0000
»> |
i
Obr. 3.2 Vyuziti matematickych vyraz( a proménnych k definici matic a vektort

Tvorba dlouhych vektoru a matic:

Popsany zpUsob tvorby matic, resp. vektor(, je doporucen pro neprilis velky pocet
radkud ¢i sloupctll. Pri potfebé generovat dlouhé vektory, napf. s mnoha desitkami Gi
stovkami prvkd, je tfeba vyuzit jiny zpUsob. Predpokladejme, Ze potfebujete vytvorit
¢asovou osu pro néjaky graf. Pljde tedy o vektor, nazvany napf. Osat. Zapiste:
Osat=0:2*pi/20:2*pi a potvrdte pomoci ENTER. Odezvu ukazuje obr. 3.3. Cisla
v zapisu vektoru predstavuji startovaci prvek, krok a cilovy prvek vektoru Osat a jsou
oddéleny dvojteckou.

Fr Ozat=0:2%pisf20:2%pi

Oszat =

Columns 1 through 7

0 0.3l4z 0.6283 0.9425 1.2566 1.5708 1.8a50
Columns & through 14
2.1991 2.5133 2.8274 3.1416 3.4558 3.7699 4,0841
Columnz 15 through 21
4.3982 4,71z24 5.0265 £.3407 5.6549 5.9690 f.2832
>> |
Obr. 3.3 Tvorba ,dlouhého” radkového vektoru
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Obr. 3.3 ukazuje vypis véech 21 prvk(i celého vektoru Osat. Je tfeba poznamenat,
Ze u definic velmi dlouhych vektor(i ¢i matic je vhodné pouzivat stfednik na konci
vyrazu. Jinak totiz dojde k €asto dlouhému vypisovani €isel, coz jen zdrzuje od prace.
Pokud se to stane, staci stisknout klavesy Ctrl-C a zdlouhavy vypis je zastaven.

Dlouhé vektory, vytvorené popsanym zpUsobem, Ize jednoduse sdruzovat do matic.
Vyzkousejte si to podle obr. 3.4.

Command Window Caommand Windows
=x al=0:5 = al=0:2
al = al =
1] 1 2 3 4 5 u] 1 2
=k oad=6:11 »r aZ=3: 5
az = az =
& 7 g a 1a 11 3 4 a
=r A=[al:raz] »» A=[al ai]
A = L=
1] 1 2 3 4 5 u] 1 2 3 4 5
& 7 =] El 10 11
==
> |

Obr. 3.4 Sdruzeni dvou vektort do matice
Uvedené moznosti tvorby matic a vektor( predstavuji zakladni zpUsob jejich defi-

nice. MATLAB ma i jiné zpUsoby, jak naplnit matice jejich ¢iselnymi, pfip. jinymi obsa-
hy. Pro zakladni sezndmeni se systémem vsak tyto postupy postaci.

Strucné shrnuti:

P relativné malé matice a vektory definujeme zapisem na dialogovém fadku
hlavniho okna; matice jsou zapisovany po fadcich, oddélenych strfedniky, prvky
jednotlivych radku se oddéluji mezerami nebo ¢arkami, napi. Mat=[1 2 3;4 5
6;7 8 9], Vek=[11 12 13 14],

» kdefinici delSich vektorl je vhodné pouzit specificky zpusob s vyuzitim
dvojtecek, napf. Osax=0:4*pi/100:4*pi,

P pfi zapisu deldich matic &i vektorl je vhodné pouzivat stfedniky, aby
nedochazelo k zdlouhavym vypisim prvkd, stane-li se to, pomoci Ctrl-C Ize
vypis prerusit,

P vektory Ize jednoduse sdruZovat do matic.




4 Zakladni pouziti 2D grafiky

Graficky vystup je pro technika nezbytnou potfebou, nebot',obrazek povi za tisic
slov®, jak pravili jiz stafi Cinané. MATLAB v tomto sméru poskytuje znaéné moznosti
jak dvojrozmérné (2D), tak i trojrozmérné (3D) vizualizace vysledk.

4.1 Strucény privodce pracovni plochou

Nové grafické okno vytvofime prikazem
figure

zapsanym do hlavniho okna Command Window. Zalozi se grafické okno Figure No. 1
jako Seda plocha. Okno se opét chova jako bézné ,windowsovské® — Ize jej posouvat,

zmenS$ovat atp.

-} MATLAB _lalx|

Fie Edt Vew Web Window Hep
Do Bl |l ? |Cunu-w'rcdury.|c.'MATLAEﬁ121qum HJ

Lanch Pad BB || corand Hindae

-

A ATLAE =
ﬂ Conmunicetions Toolbox

To yet started, sclect "MATLAR Help™ from the Help menu.

[+ -ﬂ Contrel Svstem Toolbox > Elgqure

ol Fuzzy Logic Toolbax |} B

ﬁ Tuage Processing TooLDox

B Motorole DEP Desrzlopes's Eit
ﬂ Teural Network Toolbox

\I)—ﬂ Optinization Toolkox

] vaunenpan [ Worksgsee J Figure No. 1 Sil=1t]
Command Hislory File  Edit Vew Insert Took Widow HEp )
3:52 M 4/03/02 --% ”|‘_‘1 SHES I MNAA/ | BED
Cigure
4 | | 4 ‘ Caommand History Current Ciractory 1] I

Click here and drag to move ihis window.

Obr. 4.1 Vzhled pracovni plochy po zaloZeni grafického okna
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Soucasti okna jsou rozbalovaci menu a ,implicitné” i fada ikon Figure Toolbar —
Pruh nastroji obrazku. Pro ilustraci jsou na obr. 4.2 uvedena dvé menu v rozbaleném
tvaru a to menu View a Tools. Pfedevsim proto, Ze zobrazuji druhy pfistupny nastro-
jovy pruh Camera Toolbar a nékteré funkce nastroje Camera. Asi tusite, ze jde o nastroj
vyuzitelny plné az ve 3D grafice.

<) Figure No. 1 <) Figure No. 1

Fle Edt  View Insert Tools Window Help Fle Edt Vew [nsert ’m Window Help
”D 2 [ v Figure Toolbar ® A o - it ot ]
... ¥ CameraToobar . UD = & §| kA
JJQ‘ -)iix.F oo L & &bt | ® 1] fz IT @ Zoom In
200 Qut
Rotate 30

Mowe Camera

Camera Motion ¥
Camera Axis P
Camera Reset ¥

Basic Fiting
Ciata Statistics

Obr. 4.2
Rozbalovaci menu

Ikony maji formu typickou z windows; po najeti kurzoru se ve Zlutém poli¢ku obje-
vi jeji nazev.

Ikonka New Figure — Novy Soubor| [ je stale pIné funk&ni. Z prézdného obraz-
ku Figure 1 si takto hned mizeme zalozit prazdny obrazek Figure 2, atd. | dalsi
ikonky v prvni sekci jsou, jak vzhledem, tak funkci identické s ostatnimi ve ,window-
sovskych® programech: Open File — Otevfi soubor, Save Figure — UloZ obrazek,
Print Figure — Vytiskni obrazek.

Nyni si povS§imnéte druhé sekce ikon ve Figure Toolbar:

XA 2

Tukneme-li levym tlagitkem mysi na ikonu $ipky (Edit Plot) a nasledné
provedeme na plose obrazku Figure 1 ,dvojklik”, otevie se okno Editoru
vlastnosti obrazku ,Property editor — Figure®.

Pouhym pohledem je patrné, Ze zde je mozno nastavovat a ménit veSkeré atributy
a nastaveni pfisluS§ného budouciho obrazku. N&s obrazek Figure 1 je prazdny a pred-
stavuje jen $edou plochu pozadi. Ale i tu mizeme ovlivnit. Tém trochu obeznamenéj-
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I
Edit Properties for: [figqure : 1 | ﬂ:l

Style | Title | Rendering | Info |

Background color |[ 0,800 0,800 0,800] LI

Menu bar |Defau\lﬂgure menu itermns figure) LI

Figure copy short cuts
Use this to apply a2 global change to yvour figure and its contents before copying to another application.

Change template | Applyternplate| Restore noure

Ok | Cancel | Apply ||7 Immediate apply Help |

Ready

Obr. 4.3 Editor vlastnosti obrazku

§im s barevnou stupnici je jasné, Ze Skala [0,800 0,800 0,800] v rozbalovacim menu
Background color (barva pozadi), predstavuje RGB souradnice Sedé barvy. Mizeme
pfimo rozbalit toto menu a zménit si barvu podkladu. Mame-li zaskrtnuto policko Im-
mediate apply, tak se vSe dle tohoto pfikazu okamzité provede

Fj Property Editor - Figure _oix]
Edit Froperties for: [figure : 1 =] ﬂil

stde | Tite | Rendering | Info |

[=]

Background colar

e | Oy
Magenta
Cyan
Red

henu bar

Figure copy shorf
Use this to appl glue

White
Change templg g5ck

Custom color...

Ok | Cancel | Apply ||7 Immediate apply Help |

Ready

Obr. 4.4 Moznosti ovlivnéni barvy podkladu obrazku




Zakladni pouziti 3D
grafiky a dalsi typy grafi

Zakladni princip pouziti 3D (tfirozmérné) grafiky je v souladu s tim, co bylo vysvét-
leno v kapitole 4 o praci s 2D grafikou. Mnohé pfikazy pro praci s 3D grafy jsou
analogii téch dvourozmérnych, €asto jsou jim podobné i syntaxi. Rovnéz editace 3D
grafll je analogicka jejich 2D ekvivalentim. Graf 3D ma celkem tfi osy, dvé nezavisle
a jednu zavisle proménnou. Z toho vyplyvaji i nutna rozsifeni moznosti nastaveni
grafl, ale i jejich zakladnich typU. Tak jako v ostatnich kapitolach, je i zde cilem uvést
uzivatele do problematiky. Prostudovani vSech moznosti a kombinaci je pak na vasi
pili. Ctenar necht se dukladné seznami s kapitolou 4, kde je vysvétleno pouZiti a editace

2D grafa.

5.1 Vytvoreni spojitého 3D grafu
Principialné se tato Cinnost nelidi od tvorby 2D ekvivalentu. Je tfeba mit k dispozici:

P tfi vektory, popisujici osy x, y, z (dvé nezavisle a jednu zavisle proménnou),

P klisovy pfikaz pro vykresleni 3D grafu, pfip. dal$i povely pro editaci grafu
(nebo pomoci menu).

Zapiste a potvrdte:
t=0:pi/50:10*pi;
plot3(sin(t),cos(t),t).

Dojde k vykresleni zakladniho typu spojitého grafu (parametricky zadané Srou-
bovice). Aby graf vypadal Iépe, je mozné jesté dodat: grid on a axis square nebo
box on. Vytvofi se mfizka a upravi osy. Tyto jednoduché editaéni povely jsou stejné
jako u 2D grafu. Obecné je pfikaz plot3 tvoren syntaxi: plot3(X,Y,Z), kde X, Y a Zjsou
vektory nebo matice. V pfipadé matic se kresli vice kfivek pro kazdy sloupec jed-
notlivych matic. Jako u 2D grafu je mozné pfidat daldi parametry povelu plot3 pro
blizsi uréeni typu kreslenych bodl a ¢ar, barev apod. Odezva na uvedené pfikazy
jenaobr. 5.1.

Dalsi editaci vytvofeného 3D grafu Ize provést analogicky podle popisu v kapito-
lach 4.2 az 4.5 (popis os, natoCeni grafu, zména tloustky Car, editace méfitka na
osach apod.). Lze jen doporucit provadét toto pomoci tlacitek nad obrazkem. Vyuzi-
vejte napovedu help plot3 nebo okno pro interaktivni help (viz kapitolu 2.5).




Carmrmand Window hEedE M A A, B2
= t=0:piso0:10%pi;

== plotif(sin(t),cos(L), )
»» grid on

= axis sdquare

»» box on

=

Obr. 5.1 Vytvoreni zakladniho spojitého 3D grafu

5.2 Matice jako plocha

Kromé zakladniho spoijitého grafu je vSak v Matlabu zakomponovana moznost
kresleni ploSnych 3D grafii. Protoze cely systém je orientovan maticové, je matice
zakladnim objektem k dosazeni takovych velmi efektnich grafa.

3D sit'ovany graf:
Zapiste a potvrdte:
x=-3:0.125:3; vytvorfeni vektoru na ose x (jedna nezavisle proménna),
y=X; vytvorfeni vektoru na ose y (druha nezavisle proménna),
[X,Y]=meshgrid(x,y); vytvofeni zvlastni matice (mfizky), ktera umozni nasledné
3D kresleni,
Z=X."exp(—X.*2-Y.*2); definice osy zavisle promé&nné,
mesh(Z) klicovy povel pro vykresleni 3D sitovaného grafu.

Obrazek, dosazeny povelem mesh, je velmi efektni. DoSlo k vykresleni tzv. sito-
vaného, barevné kolorovaného grafu. Barevné jsou rozliSeny hodnoty zavisle pro-
ménné podle své velikosti. Hustota sité grafu zavisi na po¢tu bodl definovanych
vektorll x a y. Vyzkousejte misto povelu mesh povel meshc. Vysledny graf je pak
kombinaci grafu ploSného sitovaného a tzv. contour (vrstevnicového) grafu, viz obr. 5.2
aobr. 5.3.
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Command Window D Bﬂ n é k A A 7 E‘) E) b

P W=-3:0.125:3;

o ow=E2

»r [M,T]=meshgridix,¥):
B Z=k.Fexp(-E.M2-Y.OA2) )
*= meshiz)

=

05 gl

Obr. 5.2 Tvorba zakladniho typu 3D sitovaného grafu

Carnrnand W i 0= n 5 k A2 @ E) &b

»r x=-3:0.125:3;

B Y=

»r [M,T]=meshgrid(x,v):
»>= meshc(Z)

=

Obr. 5.3 Varianta zakladniho typu 3D sitovaného grafu

Opét Ize pouzit jiz znamé editacni povely (axis, grid on, box on atd.). Povel axis
bude mit v8ak nikoli ¢tyfi, nybrz Sest parametr(i (tfi osy misto dvou).
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